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Getting Started as an Advisor

This Getting Started guide provides an overview of the tasks you will want to complete as a
new IB Advisor. This guide is designed as a reference for new users and comprises a very

small subset of the information and features available to you through IB.

The guide assumes the following:

” That the Master account has been approved and funded.
” That you are the Advisor master.

” That you opened a trading account for your own personal trading.

Must Consider:

b

? Understand how to Log In to Account Management

b

? Activate your Secure Login System device

s

? Understand the process and timing of account funding, including:

” Master Account Funding

»” Trading Account Funding

” |nitial Funding for Client Accounts

” Add and manage client accounts:
» Add Client Accounts
” Specify Client Fees

” Set Trading Permissions

”” View Client Account Funds Status

" Use the Dashboard to view and manage client accounts

” Trade:
? Subscribe to Market Data
” Loginto TWS
» Add Market Data Lines
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Chapter 1 May Want to Consider:

» Define Allocation Groups and Methods

? Trade and Allocate for Clients

” Use Real-time Activity Monitoring

” Familiarize yourself with activity statements and other features of our reporting system

May Want to Consider:

»” Money Managers

” Opening a Paper Trading Account
”  White Branding
»” Enabling Additional Traders

» Additional Advisor Authorizations

» Link Client Accounts

»? Adding Administrators

” Customer Activity Monitor

” Investors' Marketplace
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Log In to Account Management

There are two ways to access Account Management:

” Log in from the IB website.

” Access the home page from the Trader Workstation.
To log in to Account Management from the IB website

1. From IB’s website, select Account Management from the Login dropdown listin the

upper right corner.
TRADER WORESTATION ACCOUNT MAHAGEMENT
TWS Finigh an Application
WEBTRADER AP ACCESS
..... Gaterwy Latest
WeliTrader Bea B Gatéaway Tt Loge

2. Enteryour IB Username and Password, and click Login. The Account Management

home page opens.
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Chapter 2 Failed Login Attempts

To access Account Management from Trader Workstation

1. Log in to Trader Workstation.
2. From the Account menu, select Account Management Home. The Account Management

home page opens.

For more information

» Failed Login Attempts

»  Automatic Logoff

Failed Login Attempts

After ten failed login attempts in 24 hours, your Account Management login will be disabled. If

this happens, contact Customer Service.

Automatic Logoff

If you are logged into Account Management and the system detects no activity for 30 minutes,
your Account Management session will automatically expire and you will have to log back in. A

message appears warning you that you will automatically be logged out without further activity.

Once your session expires, another message appears informing you that your session has
expired and you have been logged out. You must re-login to start a new Account Management

session.

Secure Login System

Once your account is approved and funded, IB will mail you a Secure Login Device at the
address you specified in your application. You will need to use this device anytime you log in to
TWS or Account Management. This added level of security helps to ensure that your IB account
information remains secure. Please note that your device must be activated before you can use
it.
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Chapter 2 Secure Login System

You have 14 days from the day we mail you your IB Security Device to activate the device in
Account Management. After 14 days, you are required to use the device to log into Account
Management and Trader Workstation. If you receive the device before 14 days, you can access
Account Management and Trader Workstation without using the device until you activate it or
until 14 days have passed. Once you activate the device, you must use it to log into Account

Management and TWS.

If you use an iPhone, you can also choose to use IB Key, our digital security device. For more

information, see our Knowledge Base article.

To activate your Secure Login Device

1. Loginto Account Management.

2. Click Manage Account > Security > Secure Login System.

3. Follow the instructions on the screen to activate your security device.
For more information

” To learn more about our Secure Login System, including detailed instructions on how to use

each type of security device, see the Account Management Users’ Guide.
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3

Funding

Your Advisor account structure contains multiple accounts at different levels, and can include
multiple users who have permissions to manage one or multiple accounts. The Master account
is used to receive client fees, to receive and pay commissions on allocated trades, and to pay

market data and other fees.

This section includes the following topics:

» Master Account Funding

? Trading Account Funding

” Initial Funding for Client Accounts

For more information

” For complete information on account funding, see the Funding Reference on our website.

Master Account Funding

While it is not mandatory to fund the master account, we recommend you do this because
certain fees, including market data fees, are withdrawn directly from the master account. Should

your master account accrue a negative balance at any time, market data will be terminated.

We suggest funding the master account with a minimum of $500.00, or the estimated amount of

one year's market data fees.

To deposit funds into your IB account, log in to Account Management, then click Funding >

Fund Transfers. For more information on depositing funds, see the Depositing Funds topic in

the Funding section of the Account Management Users’ Guide.

For more information

” For complete information on account funding, see the Funding Reference on our website.
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Chapter 3 Trading Account Funding

Trading Account Funding

Many Financial Advisors elect to open a 'trading account' during their master account

application. There are two ways to fund your trading account:

” Fund the trading account directly (IB recommends this option).

” Deposit funds into the master account, then transfer funds to the trading account.

For more information

” For complete information on account funding, see the Funding Reference on our website.

Direct Funding

In order to fund your trading account, IB recommends funding the account directly through one

of our available banking methods, such as Wire, Check, etc.

To deposit funds directly into your trading account

—

. Log in to your Master account via Account Management.

. Click Funding > Fund Transfers.

. Select your trading account in the Account Selector at the top of the page.

2
3
4. From the Transaction Type list, select Deposit.
5. Select your currency from the Currency list.

6

. From the Method list, select a deposit type (Wire, Check, and so on).

Transaction Type: Currency: Method: Amount:

Deposit - United States Dollar (USD) | = Choose One -

ACH Initiated By Bank

For important information about funding rules B
’ o ACH Initiated At 1B r @ Reference

Bill Payment |
Check |
|
|

Whien you submit a deposit using this page, you are creating a depasin ng Wire

Hote

7. Type the amount of your intended deposit in the Amount field. Note that you do not enter

an amount when you first set up an ACH Initiated At IB or Canadian EFT Initiated at IB
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Chapter 3 Direct Funding

deposit.

8. Select one of the following:

” Yes - Use saved bank information for new transfer request
Select this option if you want to use previously saved bank information for this deposit
request.

” No - Create new transfer request with new bank information
Select this option if you want to save new bank information for this deposit request.
This option is automatically selected if you do not have any saved any bank
information.

” No - Create new bank information only
Select this option if you only want to create new saved bank information without
transferring any funds (for example, if you are a non-US customer who is closing an

account).

8. Ifyou select either No option, complete all the fields that appear, which vary depending on
the withdrawal method you selected. The fields vary depending on your previous

selections.

Be sure to enter a Name for the bank instruction that will be saved with your bank
information. You will be able to use this bank instruction for future deposit notifications

without having to re-enter your bank information.

9. Verify that all deposit information is correct and make note of any special instructions that

appear on the screen.

” For example, for a wire deposit, you will have to instruct your bank to wire the funds to
the institution shown on the screen.
” For a check deposit, you will have to mail your check with a copy of the confirmation

screen to the address shown on the screen.

10. Decide if you want to save the information as a recurring transaction.
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Chapter 3 Transferring Funds from the Master Account

11.

If you would like to save this as a recurring transaction, click Yes, then complete all the

fields and selections in that section.

Click Continue to submit your deposit notification.

Or click Cancel to cancel the transaction.

Depending on the type of deposit notification you selected, a page appears with
additional instructions that describe what you need to provide to your bank to complete

the actual deposit of funds.

Transferring Funds from the Master Account

You can also use the Fund Transfers page in the Funding menu of Account Management to

transfer cash from the Master account to your personal trading account.

Funds which are deposited to the master account are subject to our stated hold periods. This

could cause a delay in the processing of an internal transfer to your trading account. 1B

recommends funding the trading account directly

To transfer funds from the Master account to your trading account

1.

Log in to your Master account via Account Management.

2. Click Funding > Fund Transfers.

3. Select the Master account in the Account Selector at the top of the page. The master

account is identified with the prefix “F” and sub accounts with the prefix “U.”

. From the Transaction Type list, select Internal Transfer.

Transaction Type:

Internal Tranifers | =

The Internal Funds Transfers section appears.
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Chapter 3 Transferring Funds from the Master Account

Internal Funds Transfers

Source Account Number Choose One | =
Amtunt Qo
Currency:. Choose One | =

5. Select the source account number from the Source Account Number drop-down list.

If there are any destination accounts eligible to receive an internal funds transfer, the

Destination Account Number drop-down list appears.

Internal Funds Transfers

Source Account Mumber . u - . {Cash Available for Withdrawal
Amount _':'

Currency’ Chioose One | = .

Destination Account Number Choose One | = |

6. Enter the amount of the transfer, the currency and select the Destination Account Number.

7. Click Continue.
Click Cancel at any time to cancel the transaction.
8. Verify that the details of the internal funds transfer are correct, then click Continue.

You will immediately receive an email notification containing a confirmation number.
Enter the confirmation number where indicated on the Internal Funds Transfer page, then

click Confirm.

If you did not receive a confirmation number, click Resend Confirmation Number to

receive a new one.

Advisors Getting Started Guide 15



Chapter 3 Initial Funding for Client Accounts

Initial Funding for Client Accounts

The process of funding client accounts is the same as depositing funds into the master account.
Fund deposits into client accounts can be made in a number of ways, including Wire, Check,
ACATS, and so on. To prevent any delays in an account's funding, it is important that your
clients complete the funding information portion of application. In addition, it is important for both
you and your client to understand the credit periods for deposits as this will determine when you
will be able to start trading. The credit period varies based on the deposit method. For example,
checks require seven business days after they are deposited, while a wire transfer may be

credited as quickly as the same day.

While IB does not require that a client set up banking instructions at this time, we recommend
that advisors encourage their clients to do so. This will help prevent any potential future delays
when clients want to withdraw funds. Once banking instructions have been created in Account

Management, advisors can can use them to process withdrawals on the client’s behalf.

For more information

” For complete information on account funding, see the Funding Reference on our website.
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Client Accounts

This section details the steps that you will need to take to add client accounts, specify fees and

configure trading permissions.
The following topics are included:

” Add Client Accounts by having your clients submit an application to IB.

» Specify Client Fees
»

Set Trading Permissions

” View Client Account Funds Status

” Manage client accounts using the Dashboard

»  Additional Advisor Authorizations

? Link Client Accounts

For more information

” To learn more about adding and configuring client accounts, see the Account Management

Users' Guide.

Client Applications

To trade for your clients, you must first “add” them to your Advisor account. As the Advisor
Master, you are the only one who can add clients to your Advisor account. Adding a client

requires that you:
” Add an account by having the client apply for an IB account.

” Configure client fees

s

? Set trading permissions

v
T

Have the client fund the account

o
T

Check client account funds status
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Chapter 4 Client Applications

To add an existing IB customer as an advised client, the client needs to log into Account
Management and select Link Account to Advisor/Broker from the Account Administration menu.
Note that requests to link accounts must be approved by advisors prior to 2:00 PM on Friday.

Those requests which are approved will be processed every Friday at 3:00 PM.

Advisors have two options for completing client applications; however, some may be limited to
the fully electronic method due to regulatory and other considerations. Decide which method to

use based on the characteristics and preferences of you and your client:

” Fully Electronic (for fastest processing) - You send an invitation to your client, who
completes an electronic application online. Advisors can create client account templates in
Account Management to save and re-use certain information for new client account

applications.

” Semi-Electronic with paper signature - You and your client complete an electronic

application online. At the end of the process you print the application for your client to review
and complete the deposit instructions and the security questions and answers section. The

client then signs the application and sends it to IB Account Processing.

You can log into Account Management at any time to see the status of your clients' applications.
Advisors who want to open additional accounts for themselves at a later time must use one of

the three methods listed above.
In all cases, the completed application must be sent to IB for processing.

For additional information on all of the application methods, see the Add an Account topic in the

Account Management Users’ Guide.
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Chapter 4 Fully Electronic Account Application

Fully Electronic Account Application

As the Advisor, you initiate an email invitation to your potential client, who is then required to

complete the application online.

To initiate a client invitation email

1. Log in to Account Management.

2. Click Manage Clients > Create and Link Accounts > Create > New.

3. Click Client Invitation in the Fully Electronic Application row.

4. Specify Client Fees for the new account, and enter the name and email of the potential

client.
5. Click Continue to send the client application invitation.

An email invitation is sent to the client inviting them to apply for an account at IB, with a link to
the application start page. The application will automatically be associated with your advisor

account.

Adding IRA Trust Accounts

U.S. Advisors can add IRA Trust accounts as client accounts. An IRA Trust Accountis an IRA

account held at a designated Third Party Trustee.

Adding an IRA Trust Account requires the following steps:

1. Add a Third Party Custodian from the Investors' Marketplace > Advertise Services >
Third Party Custodianpage in Account Management.

2. Complete a brief Third Party Custodian application.

3. Submit a letter or other form of documentation to Interactive Brokers that proves the
relationship between the Advisor and the Third Party Custodian.

4. While IB approves the letter or documentation, the new Third Party Custodian appears in

the list on the Third Party Custodian page.
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Chapter 4 Semi-Electronic Account Application

5. Once the proof has been accepted by IB, send an invitation to an IRA Asset Trust client
from the Manage Clients > Create and Link Accounts > Create > New page to starta

fully electronic account application.

Semi-Electronic Account Application

For clients who need some assistance completing an application, or if you prefer to meet with
your clients for a personal touch, you work with your client to complete the application. This
process is completely electronic up until the point that client reviews, completes and signs the

application.

To complete a client application electronically

1. Log in to Account Management.
2. Click Manage Clients > Create and Link Accounts > Create > New.
3. Click Electronic Client Application in the Semi Electronic Application row.
4. Select Individual as the account type and Continue.
5. Complete the Advisor Client application following instructions shown.
6. Send the completed application via print or email to your potential client.
7. Click Client Disclosures to download and print the Client Disclosures.
8. Send all pages to your potential client.
9. Once complete, return the application to IB for processing.
Specify Client Fees

You can elect to charge your clients for services rendered through one of our available billing
methods. You specify advisor fees at the time of your client’s registration, but you can modify or
add them at any time on the Configure Fees page Account Management. All fee modifications
must first be submitted electronically in Account Management and will become effective only
after the signed PDF has been received and processed by us. Please note that fee changes are

not retroactive.

Client fee schedules can be applied to accounts individually or can be stored in templates. As

an advisor, you can configure fees for one or more client accounts, or set up client fee
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Chapter 4 Specify Client Fees

schedules in templates, then assign the templates to client accounts. The use of templates

allows you to easily maintain different fee schedules for multiple client accounts. If you are a

new advisor (i.e., you just opened your IB account), then there will be a blank default client fee

template, which you can then configure with your own fee schedule.

You set client fees in Account Management using the Manage Clients > Fees > Configure

page. On this page, you can:

]

e

¥

]

]

View and sort all client accounts.

Select one or more client accounts, then view (and if necessary, modify) the current fee
schedule for those accounts.

Select one or more client accounts, then configure and apply a fee schedule to those
accounts.

Select one or more client accounts, then apply a previously saved client fee template to

those accounts.

Charge all commissions for a client account to the Advisor account by clicking the Charge
Commissions to Advisor Account check box. Note that if the Advisor Master account
balance is below $1000 when the commissions need to be posted, then the commission will

be charged to the client account.

Configure Fees
Select accountis) below to configure fees

Search: |Search A

Account Humber

05/ 182011
u 0122/ 2004
u 05/ 10/ 2004
u 03/19/2013
u 02/25/2003

View Configure Fees

Automatic billing is calculated and automatically billed to the client's account by IB. We offer a

variety of methods that can be used, including Percentage of an account's value, Percentage of
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Chapter 4 Specify Client Fees

P&L, or a Flat Fee. You can also apply High Water Marking to the billing period client fees to

offset periods of losses in a volatile market.

If you choose to use Direct Billing, IB is not involved and you are responsible for billing your

client(s) directly.

You can also charge minimum monthly fees and IRA account fees for their clients to your
Advisor Master account. Click Manage Clients > Fees > Charge Fees to Master to select this

option.
Electronic Invoices and Fee Reimbursements

For electronic invoices, you calculate the markup and submit an invoice electronically to IB on
the Advisor Invoicing page in Account Management, and that amount will automatically be
transferred from the client account to your account. Invoices submitted prior to 5:30 (17:30) PM
EST will be processed the same day (U.S. night) and appear on that day's statements. Invoices
submitted after 5:30 (17:30) PM EST will be processed on the next business day. Submit

invoices for up to ten clients per day, but only one invoice per client account per day.

For client accounts that have been configured for electronic invoices, you can reimburse fees to
client accounts up to a maximum of 50% of invoices (net of any prior rebate) for the trailing 12-
month period. Advisors can also modify or cancel pending fee reimbursements and view the

details of fee reimbursements that have already been processed.
Click Manage Clients > Fees > Invoicing to configure client invoices and fee reimbursements.

For additional information about all our available billing methods, see Advisor Client Fees topic

in the Account Management Users' Guide.
Charge Commissions and Client Fees to the Advisor

As an Advisor, you can elect to charge client commissions to your own Advisor master account
when configuring fees for a client account. Commission charges will revert to the client account
if the Advisor master account has a balance of less than 1000 USD or equivalent when the

commission charges are posted.
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Chapter 4 High Water Marking

By default, minimum monthly fees, IRA account fees and market data and research fees are
charged to Advisor client accounts. However, Advisors can elect to charge these fees to their
own Master account. Client fees will be charged to the client account if the Advisor master

account has a balance of less than 1000 USD or equivalent when fees are posted.
Charge Fees on Client Investments in Hedge Funds

You can also charge fees on the current value of the amount that your clients have invested in
hedge funds who participate in our Hedge Fund Capital Introduction Program (HFCIP), which is
part of our Investors’ Marketplace. If you have already invested funds for your client at the
Hedge Fund Investor Site (available at the Marketplace), the invested hedge fund will

automatically be enabled for the fee program.

For each client who invests in a participating hedge fund, you can charge fees based on the
Annualized Percentage of Net Liquidation Value of the current value of the client's investment
in the Fund and/or the percentage of profit and loss of the client's investment in the Fund, as
well as configure the fee posting frequency (monthly or quarterly). Your clients must approve the

fee schedule by signing a form.

To set fees based on the value of your clients' Hedge Fund investments, click Manage Clients
> Fees > HFCIP Fees.

High Water Marking

Advisors who select Percent of P&L for their client fees can apply High Water Marking to the
billing period client fees to offset periods of losses in a volatile market. You set up High Water
Marking when you select Percentage of P&L in Automatic Billing. High Water Marking lets an

Advisor:

Specify a look-back period (in quarters or years, based on the period selection in the

Percent of P&L fee schedule).

High Water Marking keeps track of cumulative losses per billing period within the specified

look-back period. A loss in any period will be added to the look-back period's cumulative
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Chapter 4 Trading Permissions

losses. A gain in any period will decrease the cumulative loss recorded to date. By default, the

look-back period is zero, which means no High Water Marking.

Prorate for withdrawals. If an advisor chooses to prorate, withdrawals in the current period
reduce any cumulative losses that are carried over from previous periods. The losses are

reduced in proportion to the percentage of equity that was withdrawn.

Note that current period losses are never adjusted by current period withdrawals, gains are not

prorated and deposits are not used to prorate losses.

Optionally initialize High Water Marking with previous periods’' losses by entering the
amount of the losses. These losses may have been incurred for the client in another account

or with another broker. Gains are applied to the oldest losses first.
High Water Marking is effective on the day we process the approved client agreement.

If you have assigned Money Managers to direct trading and investment activity for client
accounts, then you specify Wealth Manager fees as described above, and have separate fee
schedules for Money Managers. Wealth Manager fees are those fees paid to you when you
trade for client accounts. Money Manager fees are fees paid to a Money Manager when he or
she trades for client accounts, and you set those client fees on the Money Manager Assignment

page in Account Management. For more information, see Money Managers.

Trading Permissions

Each client is responsible for configuring the Trading Permissions on their account. Trading
permissions identify the products the client wishes to trade and the countries in which he or she

wants to trade them.

Clients configure their and trading permissions in Account Management by clicking Manage

Clients > Trading > Permissions.

For more information

” To learn more about trading permissions, see the Choosing and Configuring Your Account

page on our website.
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Chapter 4 Client Account Funds Status

Client Account Funds Status

You can check the funds status of your client accounts at any time using the Funding > Fund
Transfers page in Account Management. Select the account whose status you want to check

using the Account Selector.

The page displays the Cash Balance, Cash Available for Withdrawal, Withdrawable cash that
is subject to any origination restrictions (including ACH deposits initiated by the customer via
the IB website) and the amount of any pending deposit that has not yet posted to the account.

Balances

Cash Balance Cash Available for Withdrawal Withdrawable Cash Subpect Deposst Mot Vet Posted
1o Ovigination Restriction

1000000 10000, 00 1000000 000

You can also check a client's account balances from the Client Account Details page for that

account, which is accessible from the Dashboard.

Dashboard

The Dashboard lets you quickly and easily access information about your clients from a single

point of access as well as manage many aspects of each client account.
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Chapter 4 Dashboard

DaSh hﬁafd B Registration Tasks B Cient Accounts

Pending Hems E Recent Activity [
Smart Search I ount Titke. Tvoe Number. Usermame. Alias. Househ :m Statws: | All -

Account Title *  Account Type ¥ Account Number + Username * Account Alias *  Starus H
Applicant Advizar - Open
IBLLC Applicant Individual == Closed
IBLLT Applicant Individual - Closed
IBLLC Applicant Individual Open
IBLLC Applicant # Individual Closed
Applicant Advisor Open
IBLLT Applicant Joint Closed
Applicant Indrvidual Open
Applicant Individual - Open
Applicant Organization -- Closed
Applicant Individual == Closed
Applicant Individual == Closed
IBLLC Applicant Individual - Clased
IBLLC Applicant Individual - Rejecred
-- Individual == Pending
Individual = Pending
-- Individual -= Pending
-- Individual - Pending
-- Crganizatien - Pending
Individual == Pending
Indnidual - Pending

Advisors can view information about all of their clients:

]

b

b

¥

]

View lists of all open, pending, closed and rejected client accounts.

View pending items for all client accounts on a single screen.

View recent activity for the past five days for all client accounts.

Search for and sort client accounts by account title, account type, account number,
username or account alias.

Select the number of account rows you want to view at one time, and easily navigate

between multiple pages of client accounts.
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¥

»

Download a list of outstanding registration tasks for all pending client accounts to Microsoft

Excel.

Download information about all client accounts to Microsoft Excel.

and can view and manage individual client account details:

»

”»

]

e

»

]

b

b

¥

Click any client account to drill down to the account details, balances, positions and
transaction history for that client.

View pending items.

Perform account management tasks, including:

Edit account alias, advisor or broker fees, and other settings;

Running activity statements and PortfolioAnalyst reports

Print account details;

Generate a PDF version of the account application;

View all registration tasks.

Advisors can get special authorizations from clients to modify additional account settings for

that client.

Client Account Details

As an Advisor, you can view the details of any of your client accounts in from the Dashboard in

Account Management. Access account details for any open, pending, closed or rejected client

account by clicking Manage Clients > Dashboard, and then clicking any client account on any

tabbed page in the Dashboard.

On the Client Account Details page, you can:

v

¥

gt
T

b
T

b
T

s
T

v
T

Drill down to account details for any client account.

View pending items for a client account.

Edit account alias, advisor fees, and other settings for a client account.
Run activity statements and PortfolioAnalyst reports for a client account.
Print client account details.

Delete an application for a pending client account.
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” Generate a PDF version of the client account application.

” View all registration tasks for a client account.

Quickly return to the main Dashboard page by clicking your master Account ID in the

breadcrumb link located in the middle of the top of the page.
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Dashboard E = U B Registration Tasks E Client Accounts
m Pending Items [
Details Balances Positions Transaction History

Account Information Account Configuration
Account Number UL Login Authentication Wiew
Account Username Base Currency UsD
Accountibitie Applicant Excess Sweep Do not sweep excess funds Edit
Customer Typa Individual
Account Type CASH
Account Alias Edit 2 s
Trading Permissions Wiew
Application Method Semi-Electronic (Filled by master]
¢ by ) Market Data Subscriber Status Professional
Date Begun 04,/04/201
Date Opened 4/15/20M1 Investment Experience and Finandials
DetslEundsd o210 Net Worth $250,001 - $500,000
L geeh Liquid Net Worth £250,001 - $500,000
Email
i Annual Net Income 545,001 - $50,000
Regulatory Information View ek =10/ 1 - 10 / Limited
Tax Forms View Options Mot Applicable
Commodities Mot Applicable
Advisor Fees Edit  gonds =10/ 1-10 / Limited
Fes per Trade No FX Mot Applicable
Monthly Invoicing Mot Applicable Income
Objectives Growth
Quarterly Invoicing 52000 Hedging
Annualized Percent of Net
Liquidation Ubtd
Activity Statements Wiew
Annualized Flat Fea Mot Applicable
Maonthly (February 2015) View
Annual Percentage of P&L Mot Applicable
Manth to Date Wiew
Quarterly Percentage of P&L Mot Applicable
Daily (March 24, 2015) View
Funding
Bank 3 PortfolicAnalyst
Information (ACH/SEPA/EFT)
Month to Date Detailed View
Bank Information (Wire o
Withdrawals) Maonth to Date Snapshot View
Bank Information (Deposits} O
Year to Date Detailed Wiew
Recurring Transactions 1]
Year to Date Detailed Wiew
Position Instructions o
Settlement Instructions L] 12 Month Detailed View
12 Month Snapshot View
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Additional Advisor Authorizations

An advisor can get specific authorization from a client to modify additional settings in the client

account. These authorizations are listed on the Client Account Details page for open and

pending client accounts.

Authorization Categories and Specific Tasks

Here is a list of all of the tasks that an advisor can be authorized to perform in a client's account.

The listis organized by category just as on the actual authorization form. Note that not all of

these tasks affect an operation within Account Management.

Authorization to Update or Change Account Information, Account Settings, Trading Permissions

and Tax Forms:

¥

”»

]

e

»

]

b

b

¥

”»

]

e

Change Account Info (Name & Address, Email, Phone Number, Legal Residence, Mailing
address, Personal Info, Employment Info, Financial Information, Regulatory Information,
Trading objectives,

Change trading permissions and products

Change account settings (Base Currency, Account Type)

View and change account forms and tax forms.

W8/W9 functions

Change Investor Category (QIB, Accredited Investor, etc)

Statement/Confirm Delivery Settings

Trading Configuration

Market Data

Market Data Subscriber Status

Alert Notification

Paper Trading Account

Authorization to Provide or Change Banking and Transfer Instructions

e

»

ACH deposit information

ACH and wire withdrawal bank information
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”* Position instructions for ACATS and FOP inbound transfers

? Settlement instructions

Authorization to Send Third Party Payments and Wires

” Also allow withdrawals of cash and ACH to third parties in addition to named account holder

using third-party withdrawal system.

Authorization to Vote Shares and Make Elections Regarding Positions (does not affect Account

Management)

” Corporate Actions should be sent to the advisor not the client.

” Proxy delivery and voting will be done by the advisor not the client.

Authorization for Special Programs and Alternative Investments

” Hedge Fund Capital Introduction Program Agreement
” Hedge Fund Capital Introduction Program investments and redemptions

” Enroll or un-enroll in the Stock Yield Enhancement Program

Request to Send Electronic Notices, Confirmations and Account Statements only to Advisor

” Used by our Compliance department in the event that an advisor wants to control the email

address used for the client account.

To grant and view additional advisor authorizations

1. The advisor client logs into Account Management and clicks Support > Paper Forms.

2. The advisor client prints, completes and mails the Supplemental Power of Attorney and
Authorization form to us to grant his or her advisor authorization to perform additional
specific account configuration tasks for the client's account. Without this authorization, the
advisor normally is not authorized to modify these account settings. The advisor also has

access to this form on the Support > Paper Forms page.
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3. Once the authorizations are granted, the advisor can perform the additional tasks and can
click Manage Clients > Dashboard to drill down to the Client Account Details page for

the authorizing client.

There will be a section on the page that lists all of the client account tasks that have been

authorized by the client.

Addmional Adwisor Authonizations

You are authorized to perform the following tasks for this client:

Authorization to Send Third Party Payments and Wires

Authorization to YView, Update or Change Account Information, Account
Settings, Trading Permissions and Tax Forms

Authorization for 5pecial Programs and Alternative Investments
Authorization to Provide or Change Banking and Transfer Instructions

Request to Send Electronic Motices, Caonfirmations and Account
Statements only to Advisar

Authorization to Yote Shares and Make Elections Regarding Positions

Link Client Accounts

Advisors can link multiple individual and/or joint accounts for a client under a single username
and password. Once these client accounts are linked, they will be able to access Trader

Workstation, WebTrader, IB TWS for iOS, Android and Blackberry, and Account Management
for any of the linked accounts using a single username and password. For example, you might

have a client who maintains more than one account.

Linking multiple client accounts under a single username and password offers these benefits:

” Single sign-on for all accounts;

” Single Secure Login device;

»” Activity fee minimums based on consolidated commission;
” Consolidated reporting of accounts.
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To link existing client accounts

1. Log into Account Management with your username and password, then enter the codes
from your Secure Login Device as instructed on the login screen.

2. Click Manage Clients > Create and Link Accounts > Link Existing Accounts.

Link Client Accounts

Linking your clients’ multiple accounts under a single username offers the followaing benefits
Simgle sign-on for all accounts
Single Secure Login Device
Activity fee minimums are determined based on consclidated commissions

Consolidated reporting of accounts

Select the clients whose accounts you want to link: Select One ... |»

3. From the drop-down, select the client whose multiple accounts you want to link. Note that

only eligible client accounts will appear in the drop-down.

A list of all accounts for this client appears.

Link Client Accounts

The following table shows all client accounts belonging to a customer available for linking., Only usernames with the highest level security device in
possession of your client will be available for your client single username

Click here for guidelines

Usernarme Account ID Account Title Device Type
u Applicant No security device
u Applicant Binge Card

Link Accounts =

4. Click the radio button next to the account whose username you want to use for all linked
accounts. This will be the username you use to log into Account Management and our
trading platforms.

5. Click Link Accounts.
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A page opens that displays the individual and financial information for the client accounts
to be linked .

6. Review each of the line items below and, where differences exist, select the radio button
next to the entry which is correct. Note that this information must be identical across all

accounts in or the account will not be linked.

If none of the entries provided are correct, your client can correct the information on the
Manage Account -> Account Information -> Details -> Profile page and the Manage

Account -> Account Information -> Details -> Financial Information page.

7. Ifthere is saved bank information for both accounts being linked, you are prompted to

select which bank information to save.

8. After you have entered the username, password and authentication values for each
account to be linked, a screen appears that displays the individual and financial

information that you maintain for the accounts to be linked. Click Continue.

A screen appears confirming your request. If you wish to cancel your link request, click the

here link on the page.
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Trading

The Trader Workstation (TWS) is a robust platform which allows access to a variety of powerful
trading tools. Information about all of the tools which IB offers can be found on the Trader

Workstation Highlights page on the IB web site.

This section of the guide will focus on TWS basics and will show you how to:

» Subscribe to Market Data;

» Loginto TWS;

” Add Market Data Lines (ticker lines) to the TWS trading window;
» Define Allocation Groups and Methods in TWS;

” Trade and Allocate for Clients using the methods you defined;

Monitor clients’ trade activity, positions and P&L, and account balances using our Real-time

Activity Monitoring tools.

For more information

” For complete information on Trader Workstation, see the Trader Workstation Users' Guide.

Subscribe to Market Data

Before you begin trading for your clients, you will want to subscribe to market data through

Account Management. Although you can trade without data, IB does not recommend it.
To subscribe to Market Data

1. Loginto Account Management.

2. Click Manage Account > Trade Configuration > Market Data.
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Chapter 5 Subscribe to Market Data

Professional Market Data Subscriptions

We provide real-time streaming market data for the prices described below. Pleaze check the market data subscriptions you wish to recerve. All fees
listed balow are per manth. You will have the ability 1o subteribe or untubzeribe to marker data subseriptions after your account has bean activated.

To find the exact marker dara subscription, please click Marker Dara Assistant butron. Market Dara Assistant =

GClobal Morth America Europe Asia-Pacific Quote Booster
Countres Price
I8 FOREX (IDEAL PROY FOREX Free
1B X FOREX Free
Index CFD - Level | Clebal Free

Be sure to make desired selections on all tabs above before yvou click Continue

Continue =

Your current market data subscriber status (Professional or Non-Professional) is
displayed in the page title. Market data subscriptions are organized by region (North

America, Europe, Asia-Pacific).
3. Check the subscriptions you would like to receive on each tab.

Market data fees are automatically withdrawn from the Master account monthly, and data
may be suspended if the master account does not have sufficient funds to cover market

data expenses.

Click Continue.

5. Read and complete the necessary Subscriber Agreements, and then click Continue.

Most market data subscription requests and changes take effect immediately. Certain
market data subscriptions, such as the subscription to the NYSE data, require approval

from the exchange and therefore will not take effect immediately.

Advisors Getting Started Guide 36



Chapter 5 Log into TWS

Log in to TWS

The first time you log in to TWS, you’ll need to take a little time to populate your screens with
data, understand the different allocation methods you can use, and finally practice creating
orders.

We strongly recommend that you open a paper trading account as described in Opening a

Paper Trading Account to familiarize yourself with Trader Workstation’s many features without

accidentally submitting a trade.

You can run TWS directly from your Internet browser (recommended), or download the software
to your PC and launch it directly from your desktop as a standalone application. For more

information, see the Trader Workstation page on the IB web site.

To download and log in to TWS for the first time (Windows)

1. From the LOG IN menu in the upper right corner of the IB website, select TWS or
TWS Latest from the drop-down list.

2. Click the DOWNLOAD button on the TWS page that opens to install TWS on your
computer and to view download/installation instructions.

3. When the installation is complete, click the TWS icon on your desktop to log in. This
launch method is fast, but may occasionally take a few seconds longer when TWS or

Java runtime updates are published.
4. In the Login box, enter your username and password and click Login.

For subsequent sessions, you can log in to TWS simply by clicking the TWS icon on your

desktop.

For more information

” To learn more about using the browser-based TWS versus the standalone version, see the

TWS Users’ Guide.
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Add Market Data

Next, you'll want to add market data, or ticker lines, for the products you want to trade. Although

you can trade without market data, we don’t recommend it.

To add market data lines to the Quote Monitor

1. Click in the Contractfield in an empty row.

2. Enter an underlying symbol and press Enter.

* US Stocks  + 4

Last Change Change (%) Bid Size _;

CoRtract Account Clearing  Clearing &cct  Action Qu

lamzn

AMAZON.COM INC - NASDAL)
Stock

Futures ¥
Cptions ¥
SBL

AMAZON.COM IMNC - IBIS
Stock

. AMAZOMN.COM IMC - MEXI
Click the \ Stock

expand arrow
to display any
hidden

selections.

h by company name

! Eind |

1 AMAZOMN.COM INC - NASDAQ
Stock (SMART)

Stock (Directed)

Futures r
Options ¥
Combinations k
SBL

DELL INC - FWE
A ailh, -Eul';k. m"ll';'im—j‘_‘_ﬁ‘; bl A.A-"*“ L

3. Select an asset type from the picklist on the trading screen. For instruments that require an

expiry, choose a month and year, or select All to open the contract selection box.
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U76583 IB Trader Workstation

_ DELL, IBM and AAPL are all Smart-
= ‘-’ﬂ routed, and so the data lines only
Crder  Account Ti o display the primary exchange.

FEile Edit Trade

Portfolio Untitled ~weur

Last Ch.
Action CiLlat

Contract

DELL WasDag, MmMs

IBM wvsE

AAPL MaASDAD. MME

MSFT Masoag. MrMs @ISLAND

s ' MSFT is directed to Island,
which is noted in the data line.

If you choose Smart as the exchange (rather than selecting Directed and then picking a
destination) the market data is aggregated and the default order routing is Smart. From a
display perspective, ticker lines that use aggregated Smart data do not display Smartin
the data line. TWS will only show the exchange if you elect to direct route. When you
create an order, regardless of the market data selection you can modify the order routing

destination on a per-order basis using the Destination field.
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1] Contract Selection o [ x|
E!cha"ge 140 — @ Contracts: MICROSOFT CORP
L]
SMART © - underlying MSFT P/C call
AMEX . + Exchange SMART Currency USD
. Expiry 201103 Symbaol MESFT 110319C000Ze000
BATS © strike 26 Multiplier 100
BOX 'u"' LInderlying PIC Expirny Strike Exchanoe Currencytiultiplier
Strike 10117 ——— - MSFT Call 201103 26 SMART (AMEX,... LISD 100
L2 ﬂ '
24 '
25 .
26 I' :
27 :
28 o :
PiC 1.z ;
Call
FPut
L Clear ) C ok ][[% Add | [ SelectAl | [ Sort. | [ Close |

4. In the Contract Selection box, choose a contract(s) and click OK. You can limit the
contracts displayed in the right pane by selecting criteria from the Filter section. Choose

Smart as the exchange to use SmartRouting.

For more information

” For more information on market data in TWS, see the TWS Users’ Guide.

Define Allocation Groups and Methods

IB offers advisors a number of ways to allocate trades across multiple accounts based on a
single order entry. By using our Account Groups, you can allocate to your accounts by allowing
IB to calculate the distribution based on: a specified percent change of an existing position, the
amount of available equity with loan value per account, the net liquidation value per account, or

as an equal split between all accounts in a group.
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Chapter 5 Account Groups

Additionally, using our Profiles, you can manually define how a trade will allocate orders among

a group of accounts, by number or percent of shares.

For more information

»  Account Groups

» Create Allocation Profiles

» Set Allocation Defaults

Account Groups

Account Groups will automatically calculate ratios and allocate order shares to a pre-defined
group of accounts based on the selected allocation method. When you create an order and
choose a group, the order uses the default method to allocate shares amongst the accounts in

the group.

To create an Account Group

1. On the Edit menu, select Global Configuration.

2. On the Configuration screen, click Advisor in the left pane to expand that selection, then
select Account Groups.

3. Click the Create button on the right side of the window.

4. Enter a Group name. Do not use the name "All" since this is reserved by the system.

El Note: You may want to include a prefix such as "AG" in the name to identify the choice

as an Account Group when it appears in the order selection list.

5. Select a default allocation method. You can change the allocation method for each order.

Select from one of the following:

PctChange - This method increases or decreases an already existing position by the
specified percentage. Do not specify an order size. The quantity is calculated by the
system and is displayed in the Quantity field after the order is acknowledged.

Positive percents will increase a position, negative percents will decrease a position.
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BUY ORDER Positive Percent Negative Percent
Long Position Increases position No effect

Short Position No effect Decreases position
SELL ORDER Positive Percent Negative Percent
Long Position No effect Decreases position
Short Position Increases position No effect

Example 1: Assume that three of the six accounts in this group hold long positions in stock
XYZ. Client A has 100 shares, Client B has 400 shares, and Client C has 200 shares.
You want to increase their holdings by 50%, so you enter "50" in the percentage field. The
system calculates that your order size needs to be equal to 350 shares. It then allocates
50 shares to Client A, 200 shares to Client B, and 100 shares to Client C.

Example 2: You want to close out all long positions for three of the five accounts in a
group. You create a sell order and enter "-100" in the Percentage field. The system
calculates 100% of each position for every account in the group that holds a position, and

sells all shares to close the positions.

AvailableEquity - This method distributes shares based on the amount of equity with loan
value currently available in each account. Requires you to specify an order size. The
system calculates ratios based on the Equity with Loan value in each account and

allocates shares based on these ratios.

Example: You transmit an order for 700 shares of stock XYZ. The account group includes
three accounts, A, B and C with available equity in the amounts of $25,000, $50,000 and
$100,000 respectively. The system calculates a ratio of 1:2:4 and allocates 100 shares to
Client A, 200 shares to Client B, and 400 shares to Client C.
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NetLiq - This method distributes shares based on the net liquidation value of each
account. Requires you to specify an order size. The system calculates ratios based on the

Net Liquidation value in each account and allocates shares based on these ratios.

Example: You transmit an order for 700 shares of stock XYZ. The account group includes
three accounts, A, B and C with Net Liquidation values of $25,000, $50,000 and $100,000
respectively. The system calculates a ratio of 1:2:4 and allocates 100 shares to Client A,
200 shares to Client B, and 400 shares to Client C.

EqualQuantity - This method distributes shares equally between all accounts in the

group. Requires you to specify an order size.

Example: You transmit an order for 400 shares of stock ABC. If your Account Group
includes four accounts, each account receives 100 shares. If your Account Group includes
six accounts, each account receives 66 shares, and then 1 share is allocated to each

account until all are distributed.

6. The list of accounts in the Non Group Accounts section includes all accounts available to
you. To add an account to the group, select a Non Group account and click Add.
7. Click OK to save the group and its settings.

Create Allocation Profiles

Using our Profiles, you can manually specify how an order will allocate among a group of
accounts by predetermining the number of shares/contracts, or defining specific percentages or

ratios at which a trade will allocate.

To create a share allocation profile

1. On the Edit menu, select Global Configuration.

2. On the Configuration screen, click Advisorin the left pane to expand that selection, then
select Allocation Profiles.

3. Click Create and enter a profile name, preferably one based on the way you plan to

allocate shares between clients.
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E Note: You may want to include a prefix such as "AP" in the name to identify the choice

as an Allocation Profile when it appears in the order selection list.

4. In the Allocation Profile specifies area, select a method of allocating shares between

accounts:

»

b

b

Percentages - this method will split the total number of shares in the order between
listed accounts based on the percentages you indicate. For example, an order for 1000
shares using a profile with four accounts at 25% each would allocate 250 shares to
each listed account in the profile.

Ratios - this method calculates the allocation of shares based on the ratios you enter.
For example, an order for 1000 shares using a profile with four accounts set to a ratio of
4,2,1, 1 would allocate 500, 250, 125 and 125 shares to the listed accounts,
respectively.

Shares - this method allocates the absolute number of shares you enter to each
account listed. If you use this method, the order size is calculated by adding together

the number of shares allocated to each account in the profile.

5. Click in the Account field to view all accounts. Select an account and tab over to the Value
field.

6. Enter the percent, ratio or number of shares to be allocated to the selected account (you

may need to delete the current value). Tab to create a new accountline.

El Note: If you use percentages to allocate shares, percentages allocated must equal 100.

If you use ratios, The system automatically calculates these percentages.

7. Continue until you have listed all the desired accounts for the current profile, and click OK.
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Set Allocation Defaults

The default allocation refers to the allocation that will be used automatically when you create an
order. You can modify the allocation on a per trade basis, and change the default allocations at

any time.

To set default allocations

1. On the Edit menu, select Global Configuration.
2. On the Configuration screen, click Advisorin the left pane to expand that selection, then

select Default Allocation.

on P ?2@ &

Advisor - Default Allocation

s I Use currently subscribed account
© (@ Use specified default

(@ Automatic Allocation

Group Group ¥ | CreateiModify.. |
method Metlin -
Fercentage 15

() Manual Allacation
Allocation Profile =Select= - CreatesModify...

[ | Sindle Account Allocation
Accaunt =5elect= -

@ Preserve default () Use last submitted as a default

. Ifane ar more accounts fails to meet the margin requirements when an arder is submitted:
. (@ Rejectthe entire order

: I Reduce the size of the order

3

3. Select default settings, which are described below:
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” Use currently subscribed account - check this button to automatically allocate trades
to the account or group selected in the Select Account dropdown on the trading
window, as shown in the image above.

” Use specified default - check this button to set a specified absolute default allocation.

* Automatic Allocation - choose a user-defined Account Group and method to use
for default allocation.

” Manual Allocation - choose an Allocation Profile to use as the default.

” Single Account Allocation - choose an individual account to use as the default
allocation. NOTE: To allow the last selected individual account to be used for the
default allocation going forward, select the Use currently subscribed account radio
button at the top of the page.

” Preserve default - select to always use the default set up in the Default Allocation
window regardless of changes you make on a per-order basis. If this is checked, you

will need to use this window to modify the default allocation.

” Use last submitted as a default - select if you want the default allocation to change to
the allocation you set on a per-order basis. If this is checked, the default allocation

automatically changes when you change the allocation on an order.

” If one or more accounts fails to meet the margin requirements when an order is
submitted - For each order, all accounts designated for order allocation are vetted
before the order is submitted, to ensure that each account has the capacity to support
the designated allocation. In cases where one or some account(s) cannot hold the

allocation as specified, the advisor can elect to:

” Reject the entire order - The entire order is rejected.
” Reduce the size of the order - The order size is reduced by the quantity that

cannot be held, and this quantity is deactivated.

Note that once the order has been submitted and is working, the quantity of the working order
may still change. For example, if an unrelated fill results in one or more of the accounts no
longer being able to support the allocation, the order size will be reduced by that quantity. In an

opposite scenario, if an account whose allocation was deactivated can now support the
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allocation, a quantity that was deactivated during the initial order submission may be

reactivated and submitted.

Trade and Allocate for Clients

Once you have ticker lines in Quote Monitor and defined your account groups and/or allocation
profiles, you're ready to start trading. There are many different ways to create and send orders
from within TWS, but at this point we will focus on creating and sending orders directly from the

ticker line in the Quote Monitor.

You create an order from the Quote Monitor by clicking the bid or ask on the ticker line of the

asset you want to trade. TWS automatically creates the order directly beneath the related ticker.
We call this a double-line display, and it's helpful to understand that the double row of headers
along the top of the window corresponds to the double-line market data/order row display in the

body of the window. The column headings in the top row correspond to data in ticker line.

M U12345 IB Trader Workstation e
File Edit Trade Account Trading Toals Apalytical Tools View  Help y
i) - LY . | (T
B '\J‘i" &"? E = F u Jkﬂ L J‘w- b ]
Order  Account Trade Log BookTrader OptionTrader mlerts FXTrader Chart Portfolic Cal. Configure

Portfolioc X US Stocks  Pending (All) * l;‘

e Last chnmg ~hg %  Bid Size Bad Ask Lsk 5128 Pasition Ad

u] 3 = ——

pe  Lmt Price Status T

DELL HASDAG. NM 3.52 -0.13 -0.95%

IBM rvse 16.93

BAPL HASDAG, HME 4 =1.62

MSFT HASDAS.NMS @IE... 3 =002 -0.079%

“MW“_E__HM& L TR N Y A-,/A“ masb. P W Mool st - .

Imagine now that I click the Ask price in the IBM ticker line. An order to buy 100 shares of IBM
stock is created directly below the ticker, and the column titles on the bottom row apply to these

fields, with the Allocation = Group 1, Method = Avail, TIF = DAY and so on.

To create and transmit an order for multiple clients
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1. Click the "Ask" or "Bid" price of an asset to create an Order Management line directly

below the asset’s ticker.

” Clicking the Ask will create a Buy order.

” Clicking the Bid will create a Sell order.

2. Use the Allocation field drop-down list to select an Account Group, Account Profile, a
single account or All accounts.
or
Right-click on the order and select Modify then select Share Allocation.

3. In the Allocation dialog box, select an Account Group in the Automatic Allocation area, an

Account Profile in the Manual Allocation area, or select a single account.

” For the Account Group, modify the allocation method if necessary. If you choose the
PctChange method, enter a positive or negative value in the Percentage field. All other
automatic allocation methods are calculated using the order size.

" If you use an Allocation Profile, select a group name.

” To allocate all shares to one account, select a single account.

4. Click OK to complete the order.

5. To Transmit, click the red "T" in the Transmit field.

Real-time Activity Monitoring

The Account window lets you monitor every aspect of your client account activity. The Account
window displays, among other things, the values of your positions, the funds available for
trading and the amount of margin cushion an account has before it may become subject to a

liquidation, all with real-time values.

The Account window is divided into the following sections:

” Balances, which shows your account balances for securities, commodities and in total.

These balances don'tinclude margin requirements.
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” Margin Requirements, which show your initial and maintenance margin requirements based

on your current portfolio.

” Available for Trading, which tells you what you have for additional trades and cushion

before liquidation, based on your balance information and margin requirements.

” Market Value, shows the total value of all positions, sorted by currency.

? FEX Portfolio, which shows activity for currency pair trades only. The value in the Position
field only reflects trades executed in the FX market. Please note that these do not reflect
real-time FX positions, since the non-base currency conversions are not included.

” Portfolio, which lists all current positions sorted by underlying, and displays the total current

market value for each position.

For more information on all of the parameters displayed in the TWS Account Window, see The

Account Window section in the TWS Users' Guide.

To open the Account window

1. On the main trading Toolbar, click the Accounticon, or select Account Window from the

Account menu.

File Edit Trade Account Trading Tools  Apalyt

B JJ Information
EC- L | i3 Account Window

Order 150 Accourt Portfolio windaw

Trader Dashboar| Iradeled
MO 11576.90 (+ Audit Trail

. Management
Current Maintenanc
Account Managerment Home

<~ [NDLE Stacks Mise

The first time you open the Account window, "key" account values display by default (this
default view is shown in the illustration below). The sections can be expanded and
customized by clicking the green “+” sign to the right of each section and using the

checkboxes to specify those fields you want set as your default view.
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Chapter 5

Real-time Activity Monitoring

Accowunt
File Portfolio  Currencies  Configure  Help
Accourl  Surnmany
Select Account L bl
© Balances o o
Parameter Tatal Securities Commodities
hWet Liquidation Value 995,826.47 USD 986,326.47 USD 9,500.00 USD =
Equity With Loan Yalue 969,191.47 USD 968,691.47 USD S00.00 USD =
Previous Day Equity with Loan value 961,403.48 USD 961,403.48 USD
Reg T Equity with Loan Yalue 068,691.47 USD 968,601.47 USD L
Securities Gross Position Value 1,154,181.51 USD 903,406.51 USD L]
Cash 92,419.96 USD §2,919.96 USD 9,500.00 USD =
accrued Interest 0.00 UsD 0.00 UsD 0.00 usD L
G Margin Requirements T =
Parameter Total Secunties Commodities
RegT Margin 442 BBE. TS LISD 442, 885.75 USD L
Current Imtial Margin 277,013.10 USD 265,763.10 USD  11,250.00 USD =
currant Maintenance Margin 267,347.35 USD 258,347.35 USD 9,000.00 USD =
Look Ahead Initial Margin 288,263.10 USD 265,763.10 UsD  22,500.00 wsD
Logk Ahead Maintenance Margin 276,347.35 USD 258,347.35 USD  18,000.00 WsD
Owarnight Initial Margin 288,263.10 USD 265,763.10 USD  22,500.00 wsD ]
Owemight Maintenance Margin 276,347.35 USD 258,347.35 USD  18,000.00 USD L
O Available for Trading w =
Farameter Total Secunties Commodities
Current Available Funds 701,178.37 USD 702,928.37 USD  -1,750.00 USD
Current Excess Liquidity T10,844.12 USD 710,344.12 USD 500.00 USD =
Special Memorandum Account 1,194,607.88 USD 1,194,607.88 USD L4
Look shead Available Funds 689,928.37 USD ¥02,928.37 USD -13,000.00 USOD
Look Ahead Excess Liguidity 701,844.12 USD 71034412 USD -8,500.00 USD L
Dvernight Awailable Funds 689,928.37 USD T02,928.37 USD -13,000.00 USD O
Owernight Excess Liguidity 701,844.12 USD 710,344.12 USD  -8,500.00 wso L]
Buying Power £,318,801.27 USD »
Leverage 0.92
Look Ahead Mext Change @ 16:00:00 LI
Day Trades Left (T,..., T+4) Urilimited O
© Market Value - Real FX Balance PTe=-
Curre... Total Cash Stock Options Fukures  FOPs MELgdtnvl  Unrealized PRl Rlzd PaL
UsD 92,419.96 BBS5,771.51 17,635.00 115.00 0.00 995,826.47 186,480.41 0.00
Lt

G FX Portfolio - Virtual FX Position

-

Lasiupdated at 14:08

Advisors and other multi-client account holders will see a drop-down Select Account field

on the Account and Summary tabs to select either an individual account or an account

group.
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¢ Account

File  Portfolic  Currencies  Caonfigure  Help

Account  Summany

Select Account 1 b
© Balances — “oUps o
goAl Tata
Accoumnts ool
g aliast 0.0
clignt alias Tl

tws client 2 alias

© Margin Reqy |, —
! U Tota
________ nm

On the Account page, elect to display account information for All accounts, any individual
account including the Master, or a user-defined Account Group, which includes a subset

of accounts (in the image above, Group 1 is a user-defined account groups).

On the Summary page, choose to view the account summary for All accounts, or for any

Account Group.

Advisors can also print the summary page by selecting Print Summary from the File menu.

View Account Balances

The Balances section shows your account balances for securities, commodities and in total.

These balances don'tinclude margin requirements.

To view all Balances values, expand the section using the green plus (+) sign. To customize
this view to show only the values you want to see, put a check next to these parameters and

click the green minus (-) sign to contract the section.

© Balances W o
Parameter Total Secunties Commodities
Het Liquidation Yalue 995, B26.47 USD 986,326.47 USD 9,500.00 USD
Equity With Loan Yalue 959,191.47 USD 968,691.47 USD 500.00 USD =

Previous Day Equity with Loan Value 061,403.48 USD 961,403.48 USD
Reg T Equity with Loan Value 968,691.47 USD 9568,6091.47 USD
Securities Gross Position Value 1,154,181.51 USD 202,406.51 USD
Cash 92,419.96 USD B2,919.96 USD 9,.500.00 USD =
Accrued Interest 0.00 UsSD 0.00 UsD 0.00 UsD
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Real-time Margin Monitoring

Use real-time margin monitoring to see your current margin requirements at a glance, and to
understand the margin implications of any transaction before you transmit an order. The
Account window shows your account details, including the current market value and portfolio.

Use the Margin Requirements and Trading Limits section to monitor your margin.

© Margin Regquirements =
Paramefter Total Securnties Commodities

RegT Margin 442 ,885.75 USD 442 BB5.75 USD J

Current Iratial Margin 277,013.10 USD 265,763.10 USD 11,250.00 USD =

Currant Maintenance Margin 267,347.35 USD 258,347.35 USD 9,000.00 US0D =
Logk Ahead Initial Margin 288,263.10 USD 2658,763.10 USD  22,500.00 USD
Look Ahead Maintenance Margin 276,347.35 USD 258,347.35 USD  18,000.00 USD
Cregrright Inatial Margin 288,263.10 USD 265,763.10 UsD  22,500.00 USD
Cwamight Maintenance Margin 276,347.35 USD 258,347.35 USD  18,000.00 USD

You can also see the margin impact for a single order using the right-click Preview Order
command from an order line on the trading window. An example of the Order Preview window

is shown below.

"y Ty

T Order Preview
© APPLE INC
Contract
BAPL HASDAG.NMS
Order Description
BUY 100
Order Type LMT Routing SMART Time in Force DAY
Limit Frice 340.60

Amount Margin Impact
Armaunt 34,060 USD Curmment Change Postirade B
Commission (est) 0.42..1.02USD  Equity With Loan 12,617,752 0 12,617,752
Total nfa  Inifial Margin 902,417 10,219 912,636
Maintenance Margin 840,900 10,219 851,119

| Transmit | [ Close |

0,035 S0,000 10,000

188

To preview margin impact
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1. Use the right-click menu from an order line to select Check Margin.

2. View the order details before you transmit, including commissions, margin impact and the
order description.

3. Click Transmit to send the order from the Preview window, or Close to modify before

sending.

E Note: This feature is valid only for single-account orders. It does not work for allocated

orders.

Monitor Margin Requirements

Margin is calculated at three periods during the day: the market's open, the market's close, and
overnight. The Margin Requirements section shows your Current, Look Ahead and Overnight

margin (valid for futures only) calculations.

” The Current margin is your real-time requirement right now. If you happen to be viewing this
screen at 1:00 AM, your current and overnight margin values for your futures positions will
be identical. If you're viewing this screen during trading hours, your current margin
requirements for futures will be less than or equal to the overnight requirement.

” The Look Ahead projects what your margin requirements will be at the next margin
calculation, based on what you have in your portfolio now. If you're viewing this screen at
2:00 PM, the next calculation will be at the close. If you're viewing this screen at 1:00 AM,
the next calculation will be at the open.

” Ovemight is the requirement after regular market hours and only applies to futures.

To view all Margin Requirements values, expand the section using the green plus (+) sign. To
customize this view to show only the values you want to see, put a check next to these

parameters and click the green minus (-) sign to contract the section.
Try PM

Click to see how your margin requirements would be different if you had a portfolio margin

account instead of a RegT margin account.
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Margin Warnings

To help you stay on top of your margin requirements, we provide pop-up messages and color-
coded information to notify you that you are approaching a serious margin deficiency. TWS will

highlight the row whose value is in the distress state:

” Yellow - You have only a 5% cushion above the margin requirement

” Orange - Your margin cushion is depleted and you have a short time to enter into margin-
reducing trades before your positions are liquidated. During this time you should be able to
enter a trade that will decrease your margin requirement, but not increase.

” Red - Your positions will shortly start to be liquidated as necessary to bring your account

back within the margin limits.
For more information

” See the Margin pages on the IB website for details on margin calculations.

View Available for Trading Values

If you look at nothing else on the Account Screen, the Available for Trading values let you know
the state of your account at a glance. Your Available Funds tells you if you can put on a trade.
Your Excess Liquidity tells you whether you have sufficient cushion to maintain your current
positions, and your Buying Power tells you how much you have at your disposal including your

equity and IB's margin.

To view all Available for Trading values, expand the section using the green plus (+) sign. To
customize this view to show only the values you want to see, put a check next to these

parameters and click the green minus (-) sign to contract the section.

@ Available for Trading =
Parameter Total Securities Commodities
Current Available Funds T01,178.37 USD T02,928.37 USD  -1,750.00 LSD =
Current Excess Liguidity T10,844.12 USD 710,344.12 USD S00.00 USD »*
Special Memorandum Account 1,194,607.88 USD  1,194,607.88 USD |

Look shead Available Funds 689,928.37 USD 702,928.37 USD -13,000.00 LsSD
Look Ahead Excess Liguidity T01,844.12 USD 710,344.12 USD  -8,500.00 USD
Owvernight Available Funds 689,928.37 USD 702,928.37 USD -13,000.00 USD
Owarmight Excess Liguidity 701,844.12 USD 710,344.12 USD  -8,500.00 USD

Buying Power 2,318,801.27 USD ]
Leverage 0.92
Look ahead Mext Change @ 16:00:00
Day Trades Left (T,...,T+4) Unlimited
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View Market Value

The Market Value section shows you total value for all assets sorted by currency. Accounts with
the ability to make transfers between brokers will also have an In Transit tab to monitor DVPs
and other position transfers. In addition, the Cash column of this section is where you can view

your real-time FX position information.

B | In Transi
 Market Value -
Currency Cash Sock Options Futuras FOPs et Liquidatio... Uneealized PAL Realized PEL

ALD -19.92 0.00 0.00 0.00 0.00 -19.92 0.00 0.00 &
(CAD -41.45 0.00 0.00| 0.00| 0.0 -41.45 0.00 0.00 & |
EUR -11.16 0.00 0.00 0.00| .00 -11.16 0.00 0.00 &
HiID =249 97 0.00 0.00] 0.00| 0.00 =249.97 0.00 0.00 &
UsD 2502117 6,228.00 0.00] 0.00| 000 3131142 94,2999 0.00, & |
Total (in LIS 24 91612 &,228.00 0.00 0.00 0.00 31,206 37 94 59089 0.00, &

View FX Portfolio Values

This section shows activity only for currency pair trades. The "Position" value reflects the sum of
trades executed in the FX market only, and consequently does not reflect a real-time FX

position. Check the value in the Cash field of the Market Value section for real-time FX position

information.

1 O FX Portfolio & gl

{ [ntrct Dscrpt]  Position © | Cumency | Market Value| Market Price |Average Price| Unrlzd P&L | Realized P&L[qumdate Last
JPYUSD | 100655/ USD | 94877 0.00943 000967  -2505| 0.00|
_EUF! ush | 1EI,I:IS?_ UsD | 28.010.82] 185125 1.57251| -381BE | 0.00] ND
|CADUSD | 1,340 UsSD | 1,345.29| 1.00395 0.2834 | 20.84| 0.00) Mo
|USD.CHF | 13| CHF | 13.596)  1.04315) 1.0331 | 0.13] 0.00| Mo
USD.GBP | -4200| GBP | -2141.79 050995 050359 -26.71] 000] No
|GER.USD | -15,385 Ush | -30,170.75) 1.96105| 1.97497| 21417| 0.00| Mo

{ [EUR.GBP | -18,000) GBP | -14,23845 079102 0.7646 | -115.65 | 0.00] Mo

i [USD.EUR | -14958427 EUR |-965960.84| 064465 064793  3,004.77) 0.00] Mo

View Portfolio Values

The Portfolio section shows the current value of each position and allows you to mark any

position to be liquidated last in the event of a margin call. Accounts with the ability to make
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transfers between brokers will also have an In Transit tab to monitor DVPs and other position

transfers.

© Portfolio @ Mo
Filtler Enter et More options &

Crtrek Dsarpkn & Pas Currency MarketV... Market Price Average Pr... Unrealized ... Realized PRL Liguidata Last

YHOO 300 WSO 4,915.50 16.385% 15.50333 264.50 0.00 Mo

WTPIE 1 UsD 0.01 0.0111% 0.08 =0.04 0,00 No

TOO 100 UsD 2,716.00 27.16 20.31 585.00 0.00 No

QQQQ 200 USD  10,927.00 54,635 £2.98 331.00 0.00 Mo

MSFT 400 UsSD  11,214.00 28.035  25.96893 B26.43 0.00 No

1DCH . OLD 0 UusD 3.80 0.00 0.00 NoO

1DCK 1 UsD 1.20 1.20 3,869 =237 0.00 No

IBM  JAaN2011 1. 4 UsD G5,450.00 16,125 6.57226 3,821.09 0.00 No

IBM  1aN2011 1... 5 WsD B5.00 0.17 10,0327 -4,933.50 0.00 Mo

1BM 0O USD 102, 16... 145,955 136.91257 6,329.70 0.00 No

The Right-Click Portfolio Menu

If you select an asset in the Portfolio section and click your right mouse button, you will have

access to a BUY and SELL buttons as well as the following menu items.

@ Portfolio

Cntrct D ALERT rket... Market Price Average Pr...
o]e]ele] : 1= N0,931.00 54,655 52,98
MSFT Sart by Security Type ,214.00 28.035  25.96803
IDCX.OL0  Seort by Current Page Order 3.80

IDCX Trade ¥ Close Position 3.563
IBM 34K i 57226
IBM 1AM Transfer... Close All Positions \0.037
IBM Create Ticker Close Portion of Positions |g1257
IBKR. Adjust Average Price ,601.00 18.005 16.795
55 Set Liquidate Last , 728,00 169.31999 158.035
GO0G ] T e ,d90.00 110.90  30.81014
GOOG DRI IReRE S 79,86... 599.82501 494,05
GE Create Portfolio Page ,013.00 18.355  15.16883
ES MAaRZ011 4 UsD 250,82, 1,254,125 1,118.88...

For more information

” To learn more about other real-time activity monitoring tools, including the Trades window,
Portfolio Rebalance tool, Audit Trails, and Bulletins and System Status, see the TWS Users’
Guide.
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Opening a Paper Trading Account

Once your regular trading account has been approved and funded, you are eligible to open a
Paper Trading Account. All paper trading accounts start with 1,000,000 USD of paper trading
equity, which allows you experiment with the full range of IB trading facilities in a simulated

environment which uses real market conditions.

Once you complete the application, the paper trading account is available within 24 hours
under normal business circumstances. You will be notified by email when the accountis ready

for trading.

To apply for a paper trading account

1. Log in to Account Management.

2. Click Manage Account > Settings > Paper Trading.

Paper Trading

Uie thid page to apen & Paper Tradeng Sccount, which lets you wie the full range of 1B tradmg Facalitses in & fimalated enviranment uiing real market

conditeons

Trading permisssons, market data subscnptions, base currency, and customer type configurations in your Paper Trading &ccount will be the same as
those in your normal account. You can use your Paper Trading Sccownt sctraty in Trader Workstation (TWS) or Application Program Interface (AP}

Click Continue to actrvate your Paper Trading Account

Continue =

3. Click Continue.

The following page opens:
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Paper Trading

Specify a Paper Trading Account Username prefix and password. Your full Username will be displayed once accepted by the system on the next page

Username must incliede six lower case lemers and thres different numbers

Enter & six to eight character passwaord with at least one numeric digit and no spaces, Mote this password for future use, as it will not ke shown again

Username
Paszword

Confirm Fassword:

=3

4. Type a five-character paper trading account username in the field provided.

5. Type a paper trading account password in the field provided. The password must be from
six to eight characters and must contain at least one number and no spaces.

6. Re-type the password in the field provided, then click Continue. The system will generate
a full username for you when you click Continue.

7. You are prompted to click Yes to confirm your request for a paper trading account, or click
No to cancel your request.
Be sure to write down your username and password; your password will not be shown on

the screen again.
For more information

” For details on managing your PaperTrader account, see the Account Management User's
Guide.

Paper Trading Account Reset

All paper trading accounts start with 1,000,000 USD of paper trading equity. You may reset this

equity at any time using the Paper Trading Account Reset page in Account Management.

Simply log in to Account Management with your paper trading account username and

password, then click Trade > Paper Trading Account Reset.
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Paper Trading Account Reset

All customers will start with USD 1,000,000 of paper trading Equity with Loan Value, and this equity will fluctuarte in the same manner as production
ACCOUNES

You may reset this amount at any time by selecting an amount below and clicking Continue.

Select the reset amount for your paper account and click Continue

Select Reser Amount | =

Onlly the cash amount will be reser. For a full reser, you should cloze all positions in the paper account before resening the cath amount.
The reset will apply 1o both the master and associated client/sub paper trading accounts.
Paper account reset requests received by 1600 ET will be processed by the next day.

Paper Trading Account Statements

The Paper Trading Account Statements page lets you view and print daily statements for your
paper trading account, and download trade information to Microsoft Word and Microsoft Excel.

Daily statements cover the last 45 days.

Log into Account Management with your paper trading account username and password, then

click Reports > Activity > Statements.

“ Display By @ 1D Title Alias L Select All L Inchsde Closed Accounts | Search .

a DU DF

Activity Statements

Uz thid page 1o view Sctnaly Statemeanti and oreate and wview cutlormized ftaterments.

View Statements
To view an Activity Statement, make selections below then click View.

Sratements Date(s) = il
| L™ ] | po Concatenate All
From: April 01, 2014 5-]

To: Imwuz, 2014 !."

») Customize Statements

Advisors Getting Started Guide 59



Advisors Getting Started Guide

60



6

Reporting

This section describes the account statements and reports available to you from within Account

Management, including the following:

b

¥

”»

]

e

»

]

b

b

¥

”»

]

e

Activity Statements

Customized Statements

Activity Downloads

Trade Confirmations

Flex Queries

Margin Reports

Stress Test Report
Value at Risk Report
Client Summary Report
P/L Markup Report
Advisor Fee Cap Report

PortfolioAnalyst

Statement Access for Clients

For more information

e

For complete details on all of the statements and reports available, see the Reporting Guide.

Activity Statements

Activity statements contain information about account activity, such as positions, cash balances

and transactions. Statements are generated daily, monthly, and yearly for all accounts. As a

Advisor, you can view statements for your advisor account, for individual client accounts, or a

consolidated statement which can include some or all of your accounts. In addition, clients also

have the ability to access their statements electronically through Account Management.
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Chapter 6 Activity Statements

¥

”»

]

e

»

]

Activity Statements include these features:

Expandable and contractible sections with click-down detail.

Performances summary by asset class for a quick view of an account's profitability.
Profit and loss across all transactions, positions, underlying instrument and asset class,
under First In, First Out (FIFO), Last In, First Out (LIFO), Maximize Losses and Mark-to-
Market (MTM) calculation methods, depending on the client’s selection.

Details of change in position value for the statement period.

Calculation of FX translation gains and losses for accounts with multiple currencies.

To generate an activity statement

1. Log in to your Master account via Account Management.
2. Click Reports > Activity > Statements.

Activity Statements

Use this page to view activity statements and create and view customized statements

View Statements

To view an Activity Statement, make selections below then click View.

Statements Date{s) Format Language Options
Default | Period: |Mc-nrh|-,- |v| |H‘I‘ML weu'v'| [Eng[usn = | [7] consolidated
o : e : 1 Concatenate Al

Date: August, 2014 |v]

3. Use the Account Selector at the top of the page to select one or more accounts on which
to report. To include activity from accounts you have recently closed, select the Include
Closed Accounts check box. If you choose to include closed accounts, those accounts

appear in the Account Selector.

Select Accounis: Display By: @ D Title Alias Select All Inchede Closed Accounts Search
(e —
al
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4. Inthe View Statements section of the page, make the following selections:

>

»

b

b

>

»

In the Statements list, select the statement you want to use for the statement.

In the Date(s) field, select the period (Daily, Custom Date Range, Monthly or Calendar
Year). For Custom Date Range, select the From and To dates, which define the period
covered by the statement. For Daily statements, you can select a specific date or the
last business day. For Monthly statements, you can select the last month or a specific
month. For Calendar Year (annual) statements, you can select a specific year.

In the Format field, select either HTML/WEB, PDF or Excel, depending on how you
want to view the statement.

In the Language field, select your desired language.

If you selected more than one account in the Account Selector, and want to view a
consolidated statement, select the Consolidate Selected check box. This check box
ONLY appears if you selected more than one account in the Account Selector (or if you
selected one or more accounts in a Household in the selector). You can also generate
statements for all accounts in a single statement (multiple statements are joined
together in a single statement) if you select your own master account in the Account
Selector and then select the Concatenate All check box.

If you select your own master account in the Account Selector, you have access to

client-only consolidated and concatenated statements.

5. Click View to generate the activity statement. If you selected PDF as the Format, you will

be prompted to open the generated report or save it to your computer.
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Here is an example of an HTML-based Activity Statement.

hY : Activity Statement
¥ Interactive Brokers o
Irimractive Broery (0K Lid Blels | Dl A | Caminsci A | Bring

Suh Fioer, | Carey Lase, Losdon ECEY SAE, UK. Regwlaved by F34

= Account informatson T
Same TELT ACCOUNT
Aropuns Alias Yaries
Aotount F
BLORUEY Ireiivgd F
Brvours Typr Advirior Masbr
Cungms Type Iradrvadiegl
Aotount Cigabtics Cash
Trading Permissions Fowes
Bacis Curmensy uss
= Mer Asser Value (RAY) In Base Cummency L
Prig Period Curvent Perd
Total Long Sheowrt ol Changr
Cash Fr4.82 TreAr .60 EFLE ~] 0.8
Tortall FrAEF TI4 BT (U] TR R L]
z) Cash Report T
Tokal Securiey Fuiunes UL Monih fo Deis Toar io Daie
Basr Currenay Summany
Sarnng Cas 74 87 TId 8T .00 LR os
Ersdineg Lash T34 A3 T4 A3 608 LT,
Ersdirs) Sercied Cash 74 87 Tid 8T .00 oA
&) Base Cwrrency Exchamge Rate T
&) Codes T

=) Motes Legal Nabes

Cemcral

Csantities preceded by 8 -7 1hps indicme sell raraacviont. Ok (rEnsactions ane purchases, in case of partil SXECLTIONT, COMMISEEENE &t charged on the total quantiny exeuted o the griginal ordes
The comminaion ix displayed on the S partisl sxscution only. Trade executon Gmes sre dinplayed in Castans Time

1, Plaws promgthy sport any inscoerscy or dirIRAncy in Shiy slTment, or in yosr Sooount. Contsct e 16 Curtomer Sevwics Department in wiiting uting the form svslabids on e 15 webaite

Trasraclios in Sodks, Bonds, Mubeal Fundi, Exchange Traded Commodity Febercs and Optise asd Foregn Ceernosdy
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For more information

” To learn more about activity statements, including an explanation of each statement section,

see the Reporting Guide.

Customized Activity Statements

For those who require a simpler statement format, IB allows you to create and save customized
statement. These customized statements allow you to include or exclude specific statement

sections as well as set a variety of additional statement options.

You create customized activity statements on the Activity Statements page Account

Management.
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For more information

 For more information on how to create a customized activity statement, see Customized

Statements in the Reporting Guide.

Third-Party Downloads

IB offers a number of special download formats for activity statements so you can integrate your

statements with third-party applications, including:

” Microsoft Word

” Microsoft Excel

” Microsoft Money
” Quicken

” Captools (Legacy)
” Tradelog

” GainsKeeper
In addition, the following downloads are available upon request:

” Daily Captools Downloads - Daily Captools downloads are available for customers upon
request. Send your request to enable Captools downloads to
reportingintegration@interactivebrokers.com. Note that Captools downloads are not
available to Non-Disclosed Broker Clients. If you request Daily Captools Downloads, the
Activity Downloads page will contain an additional section for Daily Captools Downloads.

” PortfolioCenter® (intended for institutional accounts; you must request downloadable files

from your IB Sales Representative first).

Access these download formats in Account Management by clicking Reports > Activity >

Downloads .

For more information

” For more information about activity downloads, see the Third-Party Downloads topic in the

Reporting Guide.
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Trade Confirmations

” For a complete list of offerings for institutional accounts, including PortfolioCenter®, open

the Reference Menu in Account Management (click Reference in the lower right corner of

any screen in Account Management), then click Reports > Third Party Integration.

Trade Confirmations

Real-time trade confirmations are generated for all executions. The Trade Confirmation report

will list trade executions separately, by asset class. Trade confirmations are available for the

entire previous calendar year and from the start of the current calendar year.

Access Trade Confirmations in Account Management by clicking Reports > Trade

Confirmations > Reports.
Here is an example of a Trade Confirmation report.

Y :
¥ Interacuve Brokers

imeriee Beoaers (UK Led

8k Floar, | Carey Lane, London DEIW BAL UK. Regulsted by FRA
= Account information
oL + TEST ACCOUMT
Azcount Aban
At F
Accounts lnchaded ¥
Arcoent Type Agvisor Masier
Customer Typs Indmaza
el Capabsnies 2
Trading Permiiusm Feerx
Base Carmeniy ush
5 Trades
At Symbsl  Trade D Sotee D BuyiSel  sxsamge Cuantity Price Procesay
Specis - Held with isteraCiive Brolers (UK Limited carried by interatiive Brouers LLC
wn
-F 1] 20030809, 152430 T 10l 14 By - " VAT TEON 18750
=F 1-0 200 5-08-09, 15:34:30 201 3-08-14 A0 - -1 1877600 187780
LT T Re— @ & 5068 (1]
Tiptal 00

) Contract Information
&) Codes

Bl Order Types

x) Mates/Legal Notes

Teamsadtions is Shedhs, Bondi, Mulual Fusdi, Exchangs Traded Commadity fuluncs and Optinad ind Fafeign ey

Comm

.08

LR

Hri

Trade Confirmation Report

deagasr |, 2013 - Novemiter T, DO1E

Expand 21 | Conpraen &5 | Prieg

¥

v Serwicn Departmend in writing uling the form svalable on the 15 webiits

For more information

” See the Trade Confirmations topic in the Reporting Guide.
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Flex Queries

Flex Queries let you specify exactly which fields you want to view in your Activity Statement or
Trade Confirmation report, the time period you want the report to cover, the order in which you
want the fields to display, and the display format, TEXT or XML, in which you want to view your
report.

You can create multiple templates with different fields for each statement. All of your templates
are stored in and run from Account Management. An Activity Flex Query is different from an
Activity Statement customized template in that you can customize a flex query at the field level,
allowing you to include and exclude detailed field information. Activity Statement customized

templates only let you include and exclude sections.

You generate and run Activity Flex Queries from the Activity Flex page. You generate and run
Trade Confirms Flex Queries from the Trade Confirmation Flex page. Both are accessible from

the Reports menu in Account Management.

For more information

” For detailed instructions, see the Reporting Guide.

Margin Reports

While the real-time margin summary is displayed in the Account Window in Trader Workstation,
our Margin Report provides you with a detailed breakdown of your positions and their
corresponding margin requirements. In order to view this detail, you must generate the Margin
Report from Account Management. The information contained in the Margin Report is based on
the margin and equity values which are obtained daily at approximately 16:15 ET for all
positions across all asset classes. Margin reports show the margin requirements for all open

single and combination positions and are available for the previous 90 days.

Margin Reports can be accessed from the Reports > Risk > Margin menu in Account

Management.

Here is an example of a margin report for an Advisor client.
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Y . Margin Report
¥ Interactive Brokers A1 oF BOVE-10-31, 16:15:00 DT

Wnteactive Brokers (UK ) Lid Hizip | Expand AN | Congract Al | Prisg
Stk Fiser, | Carey Lane, Longan ECIV BAE, U Begulated by PS8

=l Account Information T
= Margin Summany T
Sarr ity Futures - Tomal

Rase Curency
Equity with Loan Vialue 4B L=1 ) a.00 f24 82
Cah Vabes TH.B2 L] o.00 T4
Span Opticn Value 000 Q.00 000 000
-het Ligusdanon Yalue Th.BD Ll L0 Trdad
ok and Sond Value 0.0 a0 o400 oo
Ml Fund Yiles LE - LX) o.00 UL
Kan Span Dpticn Vales .00 .00 Ll noo
irnerein Payabie ketevatie Valet L - (-1 000 L]
Devigersd Fayable 'Receiwabie Walue 0 =1 1] 00 o0
IRilial Mii g Edduid el (8- [=111] L] L]
Al labeid Fungt TR} Q.00 o0 T 87
Huirfenasce Marpn Erqurement [ Q.00 00 (i)
Excess Ligusdiny T B2 Q0 .00 TRd 82

& Legal Naotes

Canieraled: 201301 =0F, 085553 E5T

For more information

” For detailed instructions on how to view a margin report, see the Margin Reports topic in the

Reporting Guide.

Stress Test Report

The Stress Test report lets you see the change in the Profit and Loss (PNL) of your positions if
the underlying price of each of your positions declines by 3%, 5%, 10%, 20% and 30% and
independently increases by 3%, 5%, 10%, 20% and 30%.

You access the Stress Test report by clicking Reports > Risk > Stress Test in Account

Management.

For more information

” For detailed instructions, see the Stress Test Report topic in the Reporting Guide.

Advisors Getting Started Guide 68


https://www.interactivebrokers.com/en/software/reportguide/am/reports/marginreports.htm
https://www.interactivebrokers.com/en/software/reportguide/am/reports/stresstestreport.htm

Chapter 6 Value at Risk Report

Value at Risk Report

The Value at Risk Summary report calculates your Value at Risk (VAR) ata 99, 99.5 and 100%
confidence levels using Principle Component Analysis. Because of the complexity of the
calculations required, this report is completed overnight and is only available once a day. If you
need real-time VAR, use the IB Risk Navigators™ in Trader Workstation, which uses a simpler

calculation.

Access the Value at Risk report in Account Management by clicking Reports > Risk > Value at
Risk.

Here is an example of a Value at Risk report.

by ; value at Risk Report
¥ Interactive Brokers Al 2004
irmaiieten Beokars LLC. T Plovich Macs. Crovmich, CT 0855 Halp | Enpaed All | Costeger AN | Prisy

& Account Information
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For more information

” For additional information on how to generate the report, see the Value at Risk topic in the

Reporting Guide.

Advisor Fee Cap Report

IB caps the amount of fees an advisor can charge a client, up to a maximum of 25% of the
client’s average equity in a given year. The Advisor Fee Cap report displays the amount of

available fee cap by client.
Access this report by clicking Reports > Supplemental > Fee Cap in Account Management.

Here is an example of an Advisor Fee Cap report:

N : Advisor Fee Cap Report
¥ Interactive Brokers - -
Interactive Srokers (UK ) Lid apgrd Al | Contract AN ) Pramg

Suh Fisar, | Carey Lane, Londen ECIV BAE, UK. Reguiated by F34

= Account Infermation 3

®) Advisor Fee Cap ?
CHent ACoosnt 1D IRt ANES Period [F OF Days) AveTage HAY Asnasnt Pasd Fee Cap Availability
s

= L0000 (el ]
L0, (L]
= GO Adus 000
+ L0 (o]
L0000 Al =5.%0
SO LEITTY .00
+ L0 [oloi]
o LOCNC, (i)
SO 000
+ L0000, oo
w LOOOOC (el
L0000 Al 201,83
= L0000 (e
= L0000 (el ]
55 caps the amoanl of advisor foes camed s asy 360-day pernod 1o 255 of the client's avirage NAV cver this period, with adantional cap limits ot 30-day Screments in-Estasen (.8, 7.2% owir e laar 30

s, 177K ower the 1841 150 dayi). The table above showi avalable adviior fee cid uieng advisor cap formula compated By 1B For mane information, please gk here

Cenerared ar: 20013-11-13, 14:22°00 EST

For more information

” For additional information on how to generate the report, see the Advisor Fee Cap topic in

the Reporting Guide.
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Client Summary Report

Advisors can run this snapshot of client balances and performance over a one-day period.
Because information on client’s statements is displayed “as of” the cut-off time for each
individual exchange, it should be noted that information on your client summary report may not

equal information on your client's statements.

Access this report by clicking Reports > Supplemental > Client Summary in Account

Management.

Here is an example of a Client Summary report:

b 3 Client Summary Report
¥ Interactive Brokers b i e

silgractive Brokers (UK. Ld Heo | Eagand AN | Contracy Al | Bring
Sth Floor, 1 Carey Lane, London EC2V SAE, UK. Regulated by FSA

x) Account Information 7

Hame
Account Allas
Account
Acoount Type

TEST ACCOUNT

Al

FO0000E {Consolidated)
Adviiser Master

Cuitamar Type EETEE AT
Account Capakilities Cask
Trading Permissions Forex
Baié Cumrency usD

=) Client Summary Ovenview 7
Total Commissions Paid 0.00
Equity with Loan Value 2,771.80
Nt Liquidation Walus 2,771.80

Trade Cash 277154
Senthed Cash 2,771.54
Inizial Margin 0.00
Ailabie Fusds 2,771.80
Mgintenance Margin 0.00
Exess Liguidity 2,771.80
Toasl MTM PAL 0.00

& Client Summary 7

CEngrated s 200 3-01-13, 14:22:26 5T

For more information

” For additional information on how to generate the report, see the Client Summary Report

topic in the Reporting Guide.
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P/L Markup Summary Report

This report shows a summary of client profit and loss (P/L) used to determine quarterly and

annual performance fees paid to an Advisor for a single client account or for all client accounts.

Access this report by clicking Reports > Supplemental > P/L Markup in Account

Management.

Here is an example of a Client Summary report:

by . P/L Markup Summary
¥ Interactive Brokers ey e
Inderactive Brokers LLE, Two Pickwick Flaza, Creenwich, £F 06850 Heip | Expand Al | Somirpct il | Prini
=l Account Information ?
x! P/L Markup Summary i
ACoount Period Rate Securities P/L Fartwres PYL Total P/L Amoum Fakd
usD

+ OO0 201 5-10-01 to 201 3-12-51 200% 428197 0.00 425197 .00
+ U0 2013-10-01 i 2013-12-31 20.0% 3,872.22 0.00 3,872.22 o0
+ 00T 2013=10=01 1o 201 3=12=31 20.0% 25,002 41 0.00 25,002 41 o.00
< OO0 201 3=10=01 13 30 20005 4,300,74 0.00 4,310.74 0.00
+ LYY 2013-10-01 1o 20 200 4,659.24 0.00 4,659,214 00
+ UK PR 201 3-10-0% to 20131 20.0% 1267259 0.00 82,6727 6,554.56
+ LY X0 2013-10-01 o 2013-12-31 20.0% 1,205,142.45 0.00 1,205,142 4% 132,834.26
+ Y YRR 2013=10=01 13 201 3=12=31 20.0% 2,705.70 0.00 2,713.70 0.00
Toaal 139, 368,82

Cererated at: 2004-05-27, 14:52:35 LOT

For more information

” For additional information on how to generate the report, see the P/L Markup Summary

Report topic in the Reporting Guide.

PortfolioAnalyst

PortfolioAnalyst allows you to evaluate the performance of your IB portfolio by creating and
saving reports based on a set of measurement criteria and optionally comparing their data to
selected industry benchmarks. You can create Detailed Reports, which let you select any
combination of report sections for a variety of performance analyses, or Snapshot Reports,
which are one-page summaries of an account's return, NAV, asset allocation and distribution of

returns. Once you create and save reports, you can run, edit or delete them.
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Advisors can also create and save cover letters called synopses and assign them to Detailed
PDF reports.

Access PortfolioAnalyst in Account Management by clicking Reports > PortfolioAnalyst.

For more information

” For detailed instructions on using PortfolioAnalyst, see the Reporting Guide.

Statement Access for Clients
Management themselves, with their username and password:

” Activity Statement

” Trade Confirmation report

” Margin report

” Activity and Trade Confirmation Flex Queries

” Value at Risk Summary report

” Stress Test Summary report

” PortfolioAnalyst

Advisors may also access their client's statements and reports through Account Management,

print them, and send them to the client.
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7

Other Features

This section introduces you to some of the other features available to Advisors at IB, including

the following:

v

* Advisor White Branding
> Enabling Additional Traders

Customer Activity Monitor

o

S
T

v
T

Money Managers

gt
T

Administrators

b
T

Investors' Marketplace

Advisor White Branding

We provide Advisors with the ability to “White Brand” specific areas of our software and
documentation. White Branding gives you the ability to display your own logos and company
information on our trading platforms and reporting systems, including Trader Workstation,
WebTrader, Account Management, statements, our registration system and the TWS Users’
Guide.

You set up your White Branding from the White Branding page in the Account Administration

section of Account Management.

To set up white branding

1. Log in to Account Management.
2. Click Manage Account > Settings > White Brand.

3. Follow the instructions on the screen to complete the form for the category or categories of

White Branding you require.
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White Branding Information

Ineraciree Brokers offers a solunion for Brokers and Professional Advisors 1o use their own banmers for Whie Branding purpeses. White Branding grees
wou the ability to display your own legos and company information on our registration system, Account Management, statements, Trader Workstation,
WebTrader, the TWS Uiers’ Guide and our contract database. White Branding 13 a great marketing toal that will alie grve your customers the
impression that you are offering a complete package of in-house trading tecds and supporting products

w | White Branding ID

¥ | Registration System, Account Management, Statements and PortfolicAnalyst
w | Emails

w | Trader Workstation Users’ Guide

w  Contract Database

4. Click Submit. Note that each category of White Branding has its own Submit button.

Under normal circumstances, White Branding changes/requests made before 5:00 PM
EST go into effect by 8:00 PM EST the same day. Changes made after 5:00 PM EST will
take effect the following day 8:00 PM EST.

For more information

” For additional information about White Branding for other systems and features, see the

Account Management Users’ Guide.

” Forissues regarding White Branding, send us an email at

whitebranding@interactivebrokers.com.

Enabling Additional Traders

You can add users to your Advisor account and grant them access to a subset of Account
Management functions using our User Access Rights system. For example, you can add grant

trading access to additional traders, reporting access for auditors, and so on.
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To add a user to the account

1. Log In to Account Management.

2. Click Manage Account > Access Rights > Users.

Users

Use this page to add users to your account, modify existing users’ informatien or access rights and delete users from your account. When you delete a
user, his or her Account Management access is disabled instantly and trading access is disabled by the next calendar day.

Security Officers

A ibl
First Name Mi Last Name User Name Type RI;::' s Status Modify Delete
chris Enderlin CEQ
Users
Ac ibl
First Name M Last Name User Name Type RI::::r f Status Modify Deleie
Meil dgfhdgfhdgf TRADER View Rights Open A x|
; Pending -
Nelson child NON_EMFLOYEE  View Rights x|
Approval
marc robles SECRETARY --
Pendin v
eme Davis Employee View Rights o =

Approval

3. Click Add User.

On the Add New User and Access Rights page, enter all required information, including
name, five-character username prefix, password, and email address.

5. On the same page, assign Account Management functions to the user for the Master
account by clicking the appropriate check boxes in the Functions section. If a function is
not checked, the user will not be able to access the function in Account Management.

6. On the same page, you can assign access rights to some or all sub/client accounts that
you want the user to access, and specify which functions you want the user to be able to
access for the sub/client accounts.

Click Continue.

8. Verify that all the information is correct, then click Continue.
If you need to make further changes, click Back, then make corrections before submitting.

9. Enter the confirmation number sent to you via email, then click Continue.
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If you have not received a confirmation number, click Request Confirm # to have a

confirmation number sent to your email address on record.
10. Click Cancel to cancel your changes.

Once the user has been successfully created, the process is not complete until the new
user completes additional verification steps by logging into Account Management with the

username and password which were created.

For more information

” To learn more about user access rights, see the User Access Rights Guide.

Customer Activity Monitor

The IB Customer Activity Monitor (CAM) helps Advisors quickly find and view all client
activities, including the complete order history and its routing sequence. Our robust user

interface displays:

” Real-time Queries: IB CAM communicates directly with the IB order routing system, which
ensures real-time data results for order and execution queries. Flexible search filters let you
narrow your queries to include specific criteria, and you can view search results in
ascending or descending order by date, underlying, price, and so on.

” Audit Trails: Track up to five days' order history, from order initiation to order execution,
including modified, cancelled and rejected orders. Also, export queries to any spreadsheet
application.

” Account Status: Find account information for any of your clients, including real-time account

balances, margin requirement and trading limits, market value and portfolio.

Access the IB CAM from the Customer Activity Monitor page on our website, or from the

Reports menu in Account Management. The username and password for accessing the CAM

will be the same as the ones created during the master account opening process.
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For more information

” For detailed instructions on how to use the Customer Activity Monitor, see our Customer
Activity Monitor Users' Guide.

Money Managers

All Professional Financial Advisors are considered to be Wealth Managers. As a Wealth
Manager, you can optionally add Money Managers to trade for your client accounts. Money
Managers direct trading and investment activity in client accounts. They cannot add client

accounts, fund client accounts, set client fees or set client trading permissions.

A Money Manager must first complete a separate Money Manager account application. Once a
Money Manager’'s account is activated, you can add him or her to your Advisor account, then
assign client accounts to the Money Manager for trading purposes, set trading permissions and

set client fees. Both Money Managers and Wealth Managers can trade for client accounts.
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Chapter 7 Money Managers

To add a Money Manager

1.

Access the Money Manager Marketplace and shop for available Money Managers. Either

contact a Money Manager directly or request that a Money Manager contact you.

. Once you and the Money Manager have agreed to do business together, add the Money

Manager to your account by using the Add button in the Money Manager Marketplace.
You can also add a Money Manager on the Manage Account > Money Manager >

Administration page if you know the Money Manager's Account ID.

Note: Money Managers must log into Account Management with their username and
password to accept assignments from Wealth Manager on the Wealth Manager

Assignment page (only Money Managers can view this page).

. Set Up a Client Fee Schedule - This fee schedule represents the fees that will be paid to

you, the Wealth Manager, when you trade for client accounts. Typically, you will have
already done this for your client accounts on the Manage Clients > Fees > Configure

page in Account Management.

You set up a separate fee schedule for a Money Manager when you set up the client

accounts for the Money Manager in the next step.

. Set Up Client Accounts - After a registered Money Manager accepts your assignment,

you can set up the client accounts for each Money Manager. This setup includes
assigning client accounts to a Money Manager, setting trading permissions for the Money
Manager and setting Money Manager client fees (fees that will be paid when the Money
Manager trades for client accounts). The client setup process takes you through a series
of pages in Account Management. You start the setup process on the Manage Account >

Money Manager > Administration page in Account Management.

” Money Managers can start trading the next business day (client assignments and
trading permissions require one business day to take effect). But Money Manager client

fees will be collected from client accounts and transferred to the Money Manager only
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after the client signs the Money Manager client agreement.

”” Note that fee per trade unitis NOT available for Money Managers.

” Client accounts assigned to a Money Manager can only receive trading permissions for
products and countries that they already have permission to trade as Advisor clients.
For example, if a client account can trade stocks as an Advisor client, and you assign
trading permissions for a Money Manager that gives the same client account trading
permissions for stocks and options, then the Money Manager will only be able to trade

stocks for that client account.

5. Create a Client Fees Template - Optionally, create a common client fee schedule to for
Money Managers without having to set client fees separately for each Money Manager.
You can create a client fees template on the Manage Account > Money Manager >
Administration page in Account Management.

6. Fund Client Accounts - When you assign a client account to a Money Manager, we
create a second version of the client account that is linked to the Money Manager. When
you fund or transfer positions into a client account for a Money Manager, you are actually

funding or moving positions into the linked client account.
Other Tasks You Can Perform as a Wealth Manager

In addition, Advisors acting as Wealth Managers can perform the following optional steps, all

available on the Money Manager Assignment page in Account Management:

” Modify Client Fees for a Money Manager - You can edit the client fees for one or more
client accounts assigned to a Money Manager. Note that any changes to Money Manager
fees require approval from the client.

” Modify Trading Permissions - You can edit the trading permissions for one or more client
accounts assigned to a Money Manager.

”” Change Money Manager Client Account Assignments - You change Money Manager
client account assignments at any time by adding or removing client accounts from the

Money Manager. Before you can remove a client account from a Money Manager, you must
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first move all cash and positions from the Money Manager-linked client account back to the
client account.

” Remove a Money Manager - When you remove a Money Manager, all client accounts
assigned to that Money Manager will be closed. Remember to move all cash and positions
from the Money Manager-linked client account linked back to the client account before you

remove a Money Manager.

The Manage Account > Money Manager > Administration page in Account Management is

shown below.

Money Manager Assignment

Use this page to

Add Money Managers, who you assign 1o your client accounts for the purpese of chent trading

View active and pending Money Managers

Remove Money Managers

Set up client accounts for Money Managers (on the Azssgn Client Accounts tab)

Modify trading permizsions and client fees for client accounts(on the Assign Chent Accounts tab)

Lie the hak to the funding pages to tranifer lund: of poditons to chent Accounts addgied 1o Money Managers

When you et up chent accounts for Money Managers, you are not changing the tradeng permisssons and chient Fees for the onginal chent accounts.

Koney Manager Assignments AssHgn Client ACCounts

Active Money Managers

Bccount Tithe Account Numbser Tradang Fermassions Client Fees Transfer Funds. Action
Applicant a Edis Edit Fungs | Pesitigns Birvier
Add Edet Clignt Fees Temolats

Pending Money Managers

You have no Pending Money Managers

¥ Add Money Manager

For more information

” For more information about Money Managers, see the Money Manager topic in the Account

Management Users' Guide.

Advisors Getting Started Guide 82


https://www.interactivebrokers.com/en/software/am/am/manageaccount/moneymanager.htm

Chapter 7 Money Manager Marketplace

Money Manager Marketplace

IB’s Money Manager Marketplace, available by clicking Investors’ Marketplace > Search
Services > Investing > Money Manager in Account Management, is an electronic forum

designed to connect Wealth Managers with Money Managers.

” Advisors acting as Wealth Managers can view information about Money Managers, review
their background information and specify their preferred contact method.

” Money Managers access the Investors' Marketplace > Advertise Services > Investing >
Money Manager page to enter information about themselves and their trading services,
including their education, certification, assets and products traded, which will be available to
Wealth Managers who access the Money Manager Marketplace; and to review contact

requests from Wealth Managers.
For more information

” To learn more about the Money Manager Marketplace, see the Account Management Users'

Guide.

Administrators

Administrators are users who have registered with Interactive Brokers for the purpose of
performing third-party administration such as reporting for other accounts. Administrators open

their own accounts and you can shop for Administrators in the Administrator Marketplace.

” An Administrator account applicant completes the Administrator registration process.

Information entered into the application is added to the Administrator Marketplace upon

account approval.

” The Administrator logs into Account Management and modifies his or her Marketplace

information if necessary.

” You open the Administrator Marketplace in Account Management to search for an

Administrator.

” You select an Administrator in the Marketplace and a request is sent to the Administrator.
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” You can also link directly to a selected Administrator by entering the Administrator's account

number.
” The Administrator is notified of the linking request and accepts (or rejects) the request in

Account Management. Once accepted, the Administrator is linked to the requesting account.

” You assign client accounts to the linked Administrator.
For more information

” To learn more about Administrators, see Administrators in the Account Management Users'

Guide.

Administrator Marketplace

Use the Administrator Marketplace to:

” Browse available Administrators.
” Select a preferred method of being contacted by selected Administrators and send contact

requests.
” Add Administrators (send link requests).

Access the Administrator Marketplace by clicking Investors’ Marketplace > Search Services

> Administrators in Account Management.
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Administrator Marketplace

The information provided on the Administrator Marketplace concerming participating Administrators is previded by the Administrators themseboes and
not by Interactive Brokers, The information is BOT a recommendation by Interactive Brokers that you should contrack for the senaces of Administrators
or for these particular Administrators. The Administrators are sndependent of Interactnve Brokers and Interactive Brokers does not make any

TERTESERTANIONS OF WAITARTIES contermng the performance of qualificanons of the Administraters or the accusacy of the infarmation provided by the
Administrators

Account Adménistraior § Location § Years Experience § Humber of Clients Services Provided §

Aglemsin est ERLITY

United Srates | years 100 TPA
MAV Comzulting United States 12 wears 150 Accountant
Parke & Associates, Lud Linaved States 13 years 150 LT e
Test Admin 1223 United States 1 years 5 Accountant
Yulish & Associates Unated States 21 years 120 TPA

For more information

 To learn more about the Administrator Marketplace, see Administrator Marketplace in the
Account Management Users' Guide.

Managing Administrators

Use the Manage Administrator page in Account Management to:

Add an Administrator by entering his or her account number.
View active and pending Administrators.

Delink an Administrator from your account.

Assign client accounts to an Administrator.

Remove client accounts from an Administrator.

Access the Manage Administrators page by clicking Investors' Marketplace > Search
Services > Administration > Manage Administrators.

The following image shows the Manage Administrators page.
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Manage Administrators

e this page 1o view, add and remove Admanistrators, and assign client acoounts 10 Adminisirarors
Adminstralors Assign Client Accounis
Active Administrators
Account Title Account ID Status Action
test Approved Delink
Pending Administrators

You have no Pending Admanistrators

For more information

To learn more about Administrators, see the Account Management Users' Guide.

Investors' Marketplace

Investors' Marketplace is a free online forum where IB customers can form connections with
service providers and do business together on Interactive Brokers' platform. Advisors can
search for service providers on the IB website or within Account Management. Advisors can
advertise their own services to potential clients on Investors' Marketplace within Account
Management, or can advertise other third-party services that they offer, such as analyst

research or software tools.

From the IB website, Investors' Marketplace is available by clicking the link at the bottom of any
page. Browse the different categories of service providers and, when you find a service provider
with whom you want to do business, you can contact the provider directly or log into Account

Management to connect, depending on the type of service provider.
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In Account Management, search for service providers from the Investors' Marketplace >
Search Services menu. Advisors can advertise their own services on the Advisor Marketplace,
available from the Investors' Marketplace > Advertise Services menu in Account

Management.

In Account Management, service providers available to advisors are organized into categories:

” |nvesting - Advisors can search for and link to Money Managers, and if they are Accredited
Investors or Qualified Purchasers under SEC rules, they can view information and about
and investin independent Hedge Funds.

” Research -Search for and connect with third-party providers of institutional-caliber research
directly in the Trader Workstation trading platform; educators who have expertise in trading,
specific products and other topics; and news wires and research feeds for Trader
Workstation.

” Technology - Search for and connect with large and small third-party vendors who have
potentially complementary software programs to expand the functionality of TWS, and
programming consultants who may be able to assist APl and FIX CTCI customers by
offering their programming expertise.

 Administration - Search for and link to registered Administrators, third-party compliance
firms, and manage your linked Administrators.

” Business Development - Search for and connect with third-party providers of advertising

and marketing services, business analysts, and individual job seekers.

Advisors who also provide research, technology, business development services or have open
positions to fill can advertise those services on Investors' Marketplace from within Account

Management.

Advertise Your Services

Advisors can market their services on the Advisor Marketplace. Once an advisor adds
information to the Broker Marketplace, other IB customers can log into Account Management
and browse the marketplace and either request that the advisor contact them or request that the

advisor add them as a client.
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The Advisor Marketplace lets you advertise your services as follows:

”»

]

e

»

]

b

b

¥

Modify your contact information

Add information about you and your business

Review contact requests by potential clients

Select whether or not you are open to new clients

Add PDF documents to your marketplace entry

Review PDF materials already posted to your marketplace entry
Approve new client requests

Add text-based articles to your marketplace entry

Advisor Marketplace

k| Advisor Contact Information

k) Upload Information Provided in Advisor Marketplace

k| Review Requests by Potential Clients 1o be Contacted 0
¥ Select Whether Advizor is Open to New Chents

k) Upload Information or Documents to be Posted for Review by Fotential Chents

k) Review Material Currently Posted on Site Concerning Advisor Business

r) Approve New Clients Requests

»)  Articles

To join the Advisor Marketplace

1.

In Account Management, click Investors' Marketplace > Advertise Services > Investing

> Advisors.

2. An electronic agreement opens. Read the agreement, type your signature in the field

provided, and then click Submit.

3. While you wait for us to approve the agreement, you can add information about yourself in

the Upload Information Provided in Advisor Marketplace section, upload information or
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documents or add text-based articles. Your contact information is added in the Advisor
Contact Information section automatically.

4. As soon as we approve your agreement, your information appears in the Advisor
Marketplace and customers shopping for an advisor can request that you contact them or

automatically add them as clients.
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